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1.0  Introduction

This document provides procedures for configuring the BayStack 150-series Ethern
hubs and for datafilling IWS positions. It covers three subjects:

• How to configure the Ethernet hub (Section 2.0 on page 11)

• How to enable common keystroke commands (Section 3.0 on page 25)

• How to datafill the TOPS IWS position (Section 4.0 on page 41)

It is necessary to read only the sections that apply to the process being followed.

1.1  Configuring the Ethernet hub

Section 2.0 provides procedures for configuring the BayStack 150-series Ethernet h
when used in a TOPS IWS Ethernet local area network (LAN) configured with the No
Networks Directory One database.

If a non-Nortel Networks directory database is used, any information about its integra
into the LAN must be sourced by the customer. It is expected that the person using 
document has access to the appropriate Site Networking Packages (SNP), which co
essential hub configuration information, such as hub IP address, subnet mask addres
default gateway address.

If the service center is not configured for Directory One, no hub configuration is requ

If your only requirement is the configuration of the BayStack hub, you need only Sec
2.0; Section 3.0 and Section 4.0 are not required for hub configuration.

1.2  Datafilling the IWS position

For datafilling a TOPS IWS position, only Sections 3.0 and 4.0 are needed. Section 
provides information on enabling the keystroke commands required in Section 4.0.
Section 4.0 provides the actual procedures for datafilling an IWS position.

A more detailed description of the procedures and files mentioned in this document ca
found inTOPS IWS Base Platform User’s Guide,297-2251-010,TOPS IWS RAMP and
Provisioning User’s Guide,297-2251-015, and in the Bay Networks publication,
Installation and Reference for the BayStack 150-series Ethernet Hubs.
DMS-100 Family TOPS IWS Network Configuration Guide  IWS 17.0 and up
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2.0  Ethernet hub configuration

The Ethernet LAN interconnects IWS operator positions to allow data to be passed am
the positions, the DMS-200 ETMS, and the optional Directory One database. If the
service center is configured with the optional Directory One database, the Ethernet 
must be configured with the appropriate network parameters. Figure 1 shows a typic
Directory One Ethernet LAN configuration.

Figure 1. Directory One Ethernet LAN configuration

Each Ethernet LAN is limited to a maximum of 20 IWS operator positions. The LANs
10 Base-T compatible.

Hub Configuration Terminal
and Cable

(optional - Customer supplied)

Router

Router

Router

Router

IOC DMS 200
(TOPS)

ETMS
OIA
Database
(Optional)X.25 protocol

Directory One
Database
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CAMS Channel Bank
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Operator
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Ethernet
Hub
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2.1  Ethernet LAN hardware

Each Ethernet LAN consists of the following components:

• Ethernet hub

• Hub configuration terminal (customer supplied)

• 24-inch open frame

• Ethernet plenum rated cables

• Ethernet patch cable (customer supplied)

• Ethernet coupler

Figure 2 shows the relationship of the LAN components to each other.

Figure 2. Components of the LAN

2.2  Ethernet hub

The Ethernet hub specified for the NTNX51DA is the BayStack 150 (NTAR25BF) 24-p
hub. For specific details not covered in this section, reference the Bay Networks
publication,Installation and Reference for the BayStack 150-series Ethernet Hubs.

Note:The BayStack 150 should not be operated with any Ethernet cables attached th
not properly terminated to an IWS position or ASN router. The cables are considere
properly terminated even if attached equipment is powered down.

Ethernet

hub*

To operator
position

Up to 20 IWS operator positions

To operator
positionPatch

cablePlenum cable

Patch
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* AC power cord
must be connected

to these components

24” open frame
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Coupler

Coupler

Hub configuration terminal
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2.2.1  BayStack 150 description

The BayStack 150 hub has the following dimensions:

Height: 1.73 inches (44 mm)

Width: 17.2 inches (437 mm)

Depth: 8.46 inches (215 mm)

Weight: 6.2 pounds (3.0 kg)

The BayStack 150 hub is equipped with

• 24 10 Base-T Ethernet RJ-45 MDI-X ports

• 1 MDI/MDI-X switchable uplink port

• 1 recessed AUI connector

• 1 RS-232 communications port

• 1 LED display

• 1 network management module

2.2.2  LED display

The LED display indicates the link, activity, and partitioning status of each port on th
hub. Table 1 provides a detailed explanation of the LEDs.

Table 1. BayStack 150 LED display details

LED label Color Activity Meaning

Master Green On The hub is serving as an active managed hub
in the stack.

Con Green On The communications port is being used for the
console interface or out-of-band network
management. The mode of the console port is
set using the console interface or an SNMP-
based network management system.

AUI Green Blinking A transceiver is attached to the AUI port on the
rear panel of the hub, and data packets are
being received through the AUI port.

Yellow On The AUI port is partitioned.

Runt Amber On The hub is receiving a packet that is too short.
Ethernet packets must be at least 64 bytes
long. Runts are often a normal side effect of
collisions.
DMS-100 Family TOPS IWS Network Configuration Guide  IWS 17.0 and up
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F/A Amber On Data packets have been corrupted during
transmission. A frame check sequence (FCS)
error occurs when a data packet fails an
internal consistency check. An alignment error
occurs when the bits in a packet do not add up
to a whole number of bytes.

L/C Amber On A collision is detected that happened after the
512th bit of a frame. Late collisions may be
caused by overly long delays in the Ethernet
network, either because a cable is too long or
there are too many repeaters or hubs on a
network.

Other Amber On One of the following Ethernet errors is
occurring:
TooLongErrors
ShortEvents
VeryLongEvents
Datarate Mismatch errors
IPG errors
Jabbers
Fragments
SFD errors

Isolate Amber On The hub has been manually segmented from
the rest of the network. Usually, the hubs are
connected together into a single Ethernet
collision domain through the Cascade
connectors on the back. Segmenting a hub
places the hub in its own collision domain
while allowing it to be managed with the rest of
the stack.

In Green On Another hub is connected to the In cascade
port on the back of the hub.

Out Green On Another hub is connected to the Out cascade
port on the back of the hub.

Collision / 1, 5, 10, >20 Amber On Collision rate is measured in units of tens of
collisions per second.

Hub ID The Unit ID of the hub is displayed. In a hub
stack, each hub unit should have a unique ID.
The hub is capable of setting the hub ID
automatically, freeing you from having to do
so. Using the Network Management Module
(NMM), you can turn on Group ID flashing,
which will make the hub ID indicator flash off
and on. This ID flashing may be useful for
identifying a specific hub or a hub stack within
a large bank of hubs.

Table 1. BayStack 150 LED display details  (Continued)

LED label Color Activity Meaning
297-2251-201 Preliminary 05.01 November 2002
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Utilization % Green Blinking The amount of data traffic is measured. When
the data traffic exceeds 40%, the last LED
blinks amber.

Link/Rx Green On The port is connected to a port on an Ethernet
device that is powered on, and the connection
between the ports is valid.

Off The port is connected to a port on an Ethernet
device that is powered off.
The connection between the port on the hub
and the port on the connected device is not
valid.

Blinking The connected port is receiving data packets.
Each data packet will be transmitted through
all other connected ports on the hub (or all
ports in the hub stack).

Disable Yellow On The port has been manually partitioned.

Autopartition Yellow Blinking The port has been automatically partitioned.

Table 1. BayStack 150 LED display details  (Continued)

LED label Color Activity Meaning
DMS-100 Family TOPS IWS Network Configuration Guide  IWS 17.0 and up
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2.2.3  Ethernet ports

Twenty-four RJ-45, 10 Base-T Ethernet ports are accessible from the front of the
BayStack 150 hub. Port 1 is a special function port, and it is not used.

Figure 3 shows the BayStack 150 hub Ethernet port specifications and RJ-45 conne
pinouts.

Figure 3. BayStack 150 hub Ethernet port specifications and RJ-45 connector pinout

2.2.4  MDI/MDI-X switch

The MDI/MDI-X switch controls the pinout of port 1 on the BayStack 150 hub. Since t
port is unused, no further information is provided. For specific details, reference the 
Networks publication,Installation and Reference for the BayStack 150-series Etherne
Hubs.

2.2.4.1  Interconnect method

The BayStack Hub may be interconnected to another BayStack hub using port 1 in
combination with the MDI / MDI-X switch.

The MDI / MDI-X switch allows you to connect the RJ-45 connector ports of the hub
directly to another 10 BASE-T hub, through the port 1 10BASE-T connector. The sw
should be set to MDI (uplink) on the hub. A standard straight-through UTP cable is
customarily used for connection to any MDI-X port.

1
2
3
4
5
6
7
8

Signal format:

10 Base-T

RX+

RX-

TX+

-

-

TX-

-

-

Ports 1 -24

(RJ-45)
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2.2.5  RS-232 communication port

Figure 4 shows the BayStack 150 Hub RS-232 communication port specifications an
cable pinout to the customer-supplied terminal.

Figure 4. RS-232 communication port specifications and cable pinout

2.2.6  AUI port

The BayStack 150 AUI port is not used. For specific details, refer to the Bay Networ
PublicationInstallation and Reference for the BayStack 150-series Ethernet Hubs.

2.2.7  Cascade ports

The BayStack 150 cascade in and out ports are not used. For specific details, refer 
Bay Networks PublicationInstallation and Reference for the BayStack 150-series
Ethernet Hubs.

2.3  Configuring the BayStack 150

This section provides information and procedures for setting up and configuring the
BayStack 150-series Ethernet hub.

You must be able to fill in Table 2 before executing these instructions. Consult the
appropriate SNP for information about the hub IP address, subnet mask address, an
default gateway address.

Note: The hub IP address must be unique to the specific hub being configured.

Table 2. IP address list

Hub IP address

Subnet mask

Default gateway

1
2
3
4
5
6
7
8
9

8
3
2

20
7
6
4
5

22

8
2
3
6
7

20
5
4

22

1
2
3
4
5
6
7
8
9

1
2
3
4
5
6
7
8
9

1
2
3
4
5
6
7
8
9

Signal format:

9600 baud
8 data bits
1 stop bit
No parity

DCD

TXD

RXD

DSR

GND

DTR

CTS

RTS

RI

Hub to Terminal Hub to PC Hub to Modem

(DB-9 to DB-9) (DB-9 to DB-25) (DB-9 to DB-25)
DMS-100 Family TOPS IWS Network Configuration Guide  IWS 17.0 and up
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2.3.1  Set up a hub configuration terminal

A customer-supplied VT-100 type terminal, a PC, or a workstation emulating a VT-10
terminal may be attached to the BayStack 150 hub for making changes to the hub
configuration. The connection can be either local or remote through a modem. For
complete details of hub management capabilities through this port, see the Bay Net
publicationInstallation and Reference for the BayStack 150-series Ethernet Hubs. Figure
6 on page 19 shows the cable pinouts for the interconnect cable.

One method that could be used is to set up an unused IWS position (or any other Win
95 based computer) to emulate a VT-100 terminal. Use the following procedure to s
the VT-100 terminal emulation.

From the Windows 95 desktop

1 Press Ctrl+Esc  to open the Start menu.

2 Use the up and down arrow keys to select Run, and press Enter .

3 In the Run dialog box type hypertrm.exe , and press Enter  to start the
HyperTerminal application.

The Connection Description dialog box appears.

4 Tab to the Cancel button, and press Enter.

The Connection Description dialog box disappears.

5 Press Alt +F to open the File menu.

6 In the File menu, use the up and down arrow keys to select Properties. Press Enter .

The New Connection Properties dialog box appears.

7 Use the Tab key to select the Connect Using pull-down menu.

8 Use the right and left arrow keys to select the port on the terminal to be used for the
hub configuration; for example, COM1.

9 After selecting the port, tab to the Configure button. Press Enter .

10 Verify that the following parameters are correctly set:

• Bits per second: 9600

• Data bits: 8

• Parity: None

• Stop bits: 1

• Flow control: None

If these parameters are correct, proceed to step 16. If changes to the settings are
required, proceed with the following steps.

11 To set the Bits per second (baud rate), tab to the Bits per second pull-down menu and
use the left or right arrow keys to select the setting 9600 .

12 To set the Data bits parameter, tab to the Data bits pull-down menu and use the left or
right arrow keys to select 8.

13 To set the Parity parameter, tab to the Parity pull-down menu and use the left or right
arrow keys to select None.

14 To set the Stop bits parameter, tab to the Stop bits pull-down menu and use the left or
right arrow keys to select 1.
297-2251-201 Preliminary 05.01 November 2002
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15 To set the Flow control parameter, tab to the Flow control pull-down menu and use the
left or right arrow keys to select None.

16 Tab to the OK button, and press Enter .

17 Use the Tab key to select the Phone Number tab of the New Connection Properties
dialog box. Then press the right arrow key followed by the Enter  key to select the
Settings tab.

18 Use the Tab key to select the Emulation pull-down menu.

19 Using the left and right arrow keys, select the VT100 option.

20 Tab to the OK button, and press Enter .

This completes the setup of the VT100 terminal emulator. Proceed to Section 2.3.1.
information on connecting the terminal to the Ethernet hub.

2.3.1.1  Connect a terminal or PC to the hub

The next task is to connect the terminal to the Ethernet hub, as shown in Figure 5.

Figure 5. Terminal connection to the BayStack 150 hub

Use the following procedure to make the connection.

1 Study Figure 6, which shows the pin assignments for the interconnect cable between
the terminal or PC and the Ethernet hub.

Figure 6. Communication port pin and signal information

2 Connect the DB-9 plug end of the appropriate straight-through cable to the communi-
cations port on the rear panel of the hub. Refer to the cable pin-out shown in Figure 6.

3 Connect the remote end of the cable into the appropriate port on the terminal or PC.

BayStack 150

(DB-9 - male)

Pin assignment Pin number and signal

DB-9 male 1 DCD (input)
2 TXD (input)
3 RXD (input)
4 DSR (input)
5 GND

6 DTR (output)
7 CTS (input)
8 RTS (output)
9 RI (input)

1 5

6 9
DMS-100 Family TOPS IWS Network Configuration Guide  IWS 17.0 and up
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2.3.2  Connect power to the hub

Use the following procedure to connect power to the hub.

1 Connect the power cable that comes with the hub to the power connector on the back
of the hub.

2 Turn on power to the hub by plugging the power cable into an outlet.

When you turn on power to the hub, the boot process begins.
After a valid connection has been established between the hub and the console,
diagnostic messages are displayed on the screen, as shown in Figure 7.

Figure 7. Power-on self-diagnostic display

Bay Stack 150 NMM POWER-ON SELF DIAGNOSTIC
------------------------------------------------------
PROM Checksum Test PASSED

PROM Checksum Test PASSED
DRAM (01024 KByte) PASSED
LED Display Test PASSED
E2PROM Integration Checksum PASSED
29F040 512 Kbytes Flash Memory Installed PASSED
Network Monitor DRAM Test PASSED
DL-P2517B NIC Test PASSED
Expansion Module Test PASSED

Stack 150 SYSTEM CONFIG AND RUN TIME IMAGE DOWNLOAD
-----------------------------------------------------

-> DUPLICATED IP CHECKING: (Hit CTRL-C to stop system boot/load
IP Address: 0.0.0.0
Subnet Mask: 0.0.0.0

Req Send ARP Reply ARP Retry Time (Sec)
-------- --------- --------- ----------
297-2251-201 Preliminary 05.01 November 2002
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2.3.3  Edit IP settings

Use the following procedure to edit the IP settings.

1 While the message DUPLICATED IP CHECKING:(Hit CTRL-C to stop system
boot/load) is displayed, press CTRL+C to display the boot Main Menu (see
Figure 8).

Figure 8. BayStack 150 Boot Main Menu display

Boot Main Menu BayStack150 Ethernet NMM
Unit: 1

MAC Address Segment
Network Interface : 000081B638E2 1

Boot Protocol IP Boot Mode local
Management ProtocolIP Image Load Mode local
Image Save Mode noAvail Config Load Mode local

*** ERROR: Menu choice was invalid ***

m - Toggle boot mode | c - System configuration menu
i - Toggle image load mode | b - Boot file configuration menu
f - Toggle config file load mode| j - IP configuration menu
k - Reset EEPROM to factory defaults | e - Load and execute boot file
z - Reset management module | w - Write boot config to EEPROM
[Esc] - Refresh boot main menu |

Enter command: _
DMS-100 Family TOPS IWS Network Configuration Guide  IWS 17.0 and up
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2 From the Boot Main Menu, press j to display the IP Configuration Menu (see
Figure 9).

Figure 9. IP Configuration Menu

3 From the IP Configuration Menu, press i to set the hub IP address.

4 Enter the IP address you have selected, and press Enter .

5 Press s to set the subnet mask.

6 Enter the subnet mask number for your network, and press Enter .

7 Press g to set the default gateway.

8 Enter the IP address for your default gateway, and press Enter .

9 Press Esc  to return to the Boot Main Menu.

2.3.4  Edit boot configuration settings

Use the following procedure to edit the boot configuration settings.

From the Boot Main Menu

1 Press m to toggle the boot mode to EEPROM.

2 Press m to toggle the boot mode to local.

3 Press f to toggle the config load mode to local.

4 Press i to toggle the image load mode to local.

5 Press w to save all parameter values to EEPROM.

The hub uses these new values during its next boot load cycle.

IP Configuration Menu Baystack150 Ethernet NMM
Unit: 1

IP Address Subnet Mask
NI 1: 128.5.3.12 255.255.255.0

Default Gateway: 128.5.13.11

i - Set IP address
s - Set subnet mask
g - Set default gateway
[Esc] - Return to previous Menu

Enter command: _
297-2251-201 Preliminary 05.01 November 2002
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6 Press z, then select y, and press Enter  to reboot the hub.

Your configuration of the BayStack hub is now complete.
DMS-100 Family TOPS IWS Network Configuration Guide  IWS 17.0 and up
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3.0  Keystroke commands (Alt+Tab, Ctrl+Esc, and Ctrl+Alt+Delete)

The following section contains information on enabling keystroke commands that are
in the IWS environment. Figure 10 shows the keyboard layout for a standard IWS
keyboard used in a non-IWS (Windows or DOS) environment.

Note:You can also enable the use of a customer-supplied mouse. The use of a cust
supplied mouse can be enabled to facilitate the movement between IWS and MS Win
applications. The user may also be required to load the appropriate mouse drivers f
specific mouse to be used. Refer to the mouse manufacturer’s documentation for sp
information on required drivers.

Windows provides three useful key combinations:

• Alt +Tab - cycles through running applications

• Ctrl +Esc - opens the Windows XP Professional Start menu

• Ctrl +Alt +Delete - opens the Close Program window

By default, IWS base software disablesAlt +Tab andCtrl +Esc, but notCtrl +Alt +Delete.
After the IWS base application has started, however, these commands can be enab
disabled.

Figure 10. Windows or DOS environment IWS keyboard layout

Note: When used in the Windows or DOS environment, theClg key on the IWS keyboard
can also act as theDelete key.
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3.1  Enabling Alt+Tab

From the IWS logon screen, theAlt +Tab key command can be enabled on an IW
position by setting a variable called alttab to 1. Use the following procedure to
temporarily enable theAlt +Tab key command.

1. If the IWS logo window has focus, shut down the IWS base application as
follows:

a. Press Ctrl+Alt+Delete and select the Task Manager.

b. Select the Applications Tab if it is not already selected.

c. Use the down arrow key to highlight MPX BASE Application or Remot
Access Maintenance Position.

d. Use the Tab key to highlight the End Task button and then press the E
key to end the application. (Close both the IWS base and RAMP
applications if both are running.)

2. Press Ctrl+Esc to open the Start menu.

3. Go to Settings, and select Control Panel.

FIGURE 11. Control Panel location
297-2251-201 Preliminary 05.01 November 2002
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4. Double click on the System Icon to open the System Properties screen.

FIGURE 12. System Properties screen

5. Go to the Advanced tab of Systems Properties
DMS-100 Family TOPS IWS Network Configuration Guide  IWS 17.0 and up
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6. Click on Environmental variables button at bottom of the screen

FIGURE 13. System Properties Advanced tab
297-2251-201 Preliminary 05.01 November 2002
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7. Display the Environmental variables screen.

FIGURE 14. Environmental variables screen

8. Change the ALTTAB variable in the Environmental variables screen.

a. Click on ALTTAB in the System variables box

b. Click on the Edit button for the System variables.

FIGURE 15. Edit Systems Variable screen
DMS-100 Family TOPS IWS Network Configuration Guide  IWS 17.0 and up
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f. A
c. Change the Variable value to 1. Note: The default is 0, which represents of
value of 1 represents on.

FIGURE 16. Changing the system variable

d. Click OK.

e. Verify that the ALTTAB variable is set to 1 in the Environmental variables
screen.

FIGURE 17. Verify variable changed
297-2251-201 Preliminary 05.01 November 2002



31

r
S
.)

 the
 to 0.
FIGURE 18. ALTTAB variable changed

f. Click OK to return to the System properties screen.

g. Click OK to return to the Control panel.

8. The Alt+Tab command is now permanently enabled for use at the IWS logo
window.

Press Alt+Tab as needed to switch between the IWS logo window and othe
running applications (more than one application must be running). (If the IW
position is restarted again, Alt+Tab remains enabled at the IWS logo window

Later, once Alt+Tab is no longer needed, it can be disabled again. Just use
same steps, but this time, change the ALTTAB environmental variable back
DMS-100 Family TOPS IWS Network Configuration Guide  IWS 17.0 and up
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3.2  Control of Alt+Tab and Ctrl+Esc from RAMP

The RAMP can be used to enable bothAlt +Tab andCtrl +Esc commands
temporarily on designated IWS positions. Use the following procedure to
temporarily enable both commands.

1. If an IWS logo window has focus at the RAMP and Alt+TAb is NOT
enabled on the position, shut down the IWS base application as follows:

a. Press Ctrl+Alt+Delete and select the Task Manager.

b. Select the Applications Tab if it is not already selected.

c. Use the down arrow key to highlight MPX BASE Application or Remot
Access Maintenance Position.

d. Use the Tab key to highlight the End Task button and then press the E
key to end the application. (Close both the IWS base and RAMP
applications if both are running.)

2. Press Alt+Tab if needed to get a Remote Access Maintenance Position
window.

If the RAMP window does not have focus, press Alt+Esc to give it focus. It m
also be necessary to enable the RAMP’s ping setting from the Options men

3. Press Alt+T to open the Tools menu.

4. Press key P to open a Position Profile window.

Use the arrow keys to highlight and target an IWS position from the ones lis
in the Available Positions box as shown in Figure 19. Note that if this is a RAM
and general operator position, and that step 1 was not used to shut down th
MPX BASE Application, then the target position can be this RAMP itself as
shown in Figure 20.

FIGURE 19. Profile of an IWS Position
297-2251-201 Preliminary 05.01 November 2002
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FIGURE 20. Profile of RAMP

5. Press Alt+A to open an Applications Profile window.

a. Use the down arrow key to highlight the name IWS BASE in the Availab
Applications box. An example window in shown in Figure 21.

b. Press Alt+N and then arrow keys to highlight the name Start Menu Enab
in the Parameter Name box. This parameter can only be modified whe
Attribute is set to R/W.

With the parameter Start Menu Enabled set to False as shown in Figure
the Ctrl+Esc command at the target position cannot be used to open th
Windows Start menu from the IWS logo window. And Alt+Tab cannot b
used at the target position to cycle from the IWS logo window to anoth
currently running application.
DMS-100 Family TOPS IWS Network Configuration Guide  IWS 17.0 and up



34

to

the
to

,

FIGURE 21. Applications Profile Window

6. Press Alt+M to choose the Modify button and open an Application
Parameter Modification window.

a. Typetrue at the Value command line as shown in Figure 22.

b. Press Alt+S to change the setting of the Start Menu Enabled variable 
true as shown in Figure 23.

Commands Ctrl+Esc and Alt+Tab key are now temporarily enabled at 
target position. Alt+Tab can be used to tab from the IWS logo window 
another running application. And Ctrl+Esc can be used to open the
Windows XP Professional Start menu. If the target position is restarted
Ctrl+Esc and Alt+Tab are again disabled at the target position.

FIGURE 22. Setting Start Menu Enabled to True
DMS-100 Family TOPS IWS Network Configuration Guide  IWS 17.0 and up
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FIGURE 23. Start Menu Enabled Set to True

7. Use the Tab key and Enter keys to close the modification windows at the
RAMP.
DMS-100 Family TOPS IWS Network Configuration Guide  IWS 17.0 and up
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3.3  Control of Ctrl+Alt+Delete from RAMP

The Windows Ctrl+Alt+Del command is used to obtain a list of currently running
applications and it is also used to restart (soft reboot) the PC. By default, this comma
not disabled by IWS software so that it can used by maintenance personnel. Once an
position is set up to process telephone calls, the Ctrl+Alt+Del command can be disa
The RAMP can be used to disable (or enable) this command for the IWS base applic
at an IWS position as follows:

1. If an IWS logo window has focus at the RAMP and Alt+Tab is NOT enabled
on the position, shut down the IWS base application as follows:

a. a.Press Ctrl+Alt+Delete and select the Task Manager.

b. Select the Applications Tab if it is not already selected.

c. Use the down arrow key to highlight MPX BASE Application or Remot
Access Maintenance Position.

d. Use the Tab key to highlight the End Task button and then press the E
key to end the application. (Close both the IWS base and RAMP
applications if both are running.)

2. Press Alt+Tab if needed to get a Remote Access Maintenance Position win
dow.

If the RAMP window does not have focus, press Alt+Esc to give it focus. It m
also be necessary to enable the RAMP’s ping setting from the Options men

3. Press Alt+T to open the Tools menu.

4. Press key P to open a Position Profile window.

Use the arrow keys to highlight and target an IWS position from the ones lis
in the Available Positions box as shown in Figure 24. Note that if this is a RAM
and general operator position, and that step 1 was not used to shut down th
MPX BASE Application, then the target position can be this RAMP itself as
shown in Figure 25.
DMS-100 Family TOPS IWS Network Configuration Guide  IWS 17.0 and up
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FIGURE 24. Profile of an IWS Position

FIGURE 25. Profile of RAMP

5. Press Alt+A to open an Applications Profile window.

a. Use the down arrow key to highlight the name IWS BASE in the Availab
Applications box. An example window in shown in Figure 26.

b. Press Alt+N and then use arrow keys to highlight the name Ctrl+Alt+D
Enabled in the Parameter Name box. This parameter can only be mod
when its Attribute is set to R/W.

With Ctrl+Alt+Esc Enabled set to true as shown in Figure 26, the
Ctrl+Alt+Del command at the target position can be used to open a Cl
DMS-100 Family TOPS IWS Network Configuration Guide  IWS 17.0 and up
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Program window from the IWS logo window. This parameter needs to 
set to false to disable it.

FIGURE 26. Ctrl+Alt+Esc Enabled

6. Press Alt+M to choose the Modify button and open an Application
Parameter Modification window.

a. TypeFalseat the Value command line.

FIGURE 27. Setting Ctrl+Alt+Esc Enabled to False

b. Press Alt+S to set Ctrl+Alt+Del Enabled to false.

With Ctrl+Alt+Del Enabled set to false as shown in Figure 28, the
Ctrl+Alt+Del cannot be used at the target position from an IWS logo
window. Even if the PC’s power switch is used to shut down and restart
PC, the Ctrl+Alt+Del command cannot be used at an IWS logo window
DMS-100 Family TOPS IWS Network Configuration Guide  IWS 17.0 and up
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FIGURE 28. Ctrl+Alt+Del is Disabled

7. Use the Tab key and Enter keys to Close the Profile windows.

To again enable Ctrl+Alt+Del, repeat this procedure but set the Ctrl+Alt+De
parameter to true instead of false.
DMS-100 Family TOPS IWS Network Configuration Guide  IWS 17.0 and up
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4.0  TOPS IWS position datafill

This section describes methods and procedures for datafilling a TOPS IWS position

4.1  TOPS IWS provisioning tool

To edit datafill for specific site or position conditions, or to add other IWS-compliant
applications, use the Programs menu (Figure 29) of the Windows Start menu to acc
TOPS IWS base tools (Figure 30). For more information on using the IWS provision
tool, refer toTOPS IWS RAMP and Provisioning User’s Guide,297-2251-015.

Figure 29. TOPS IWS menu box
DMS-100 Family TOPS IWS Network Configuration Guide  IWS 17.0 and up
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Figure 30. Startiws pull-down menu

4.2 Datafill information

This section contains information concerning the datafill of IWS software release 10
11.0, and 12.0. See Section 4.2.1 on page 44 for information concerning IWS release
datafill.

The operation of the TOPS IWS position is dependent upon having proper initializat
files and datafill tables or files in the correct directories on each position. These are 
DMS tables or files, and therefore normal DMS controls do not apply. Many of the IW
tables do, however, correspond directly to specific DMS tables. In these cases, the d
the IWS table must match the data in the corresponding DMS table.

Certain datafill files may be overwritten during an IWS software update.The user must
manually make any custom or site-specific changes to the overwritten files. Upgrade
information about all IWS base and application files is created and placed in directo
C:\MPXBASE\TMP. This directory contains the following information:
297-2251-201 Preliminary 05.01 November 2002
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• NEWTBL.TXT: contains a list of datafill files that are new for this release. The
files did not exist in directory C:\MPXBASE\DATAFILL before the upgrade. Th
original file content with its custom data is saved in directory C:\MPXBASE\TM
to a file in the format <filename.iws>. If this is an initial install, this file will
contains a list of all .TBL, .LNG, and .KBD files that were installed.

• CHGTBL.TXT: contains a list of datafill files that were overwritten because of
differences between the original files and the upgraded files. The original file
content with its custom data is saved in directory C:\MPXBASE\TMP to a file 
the format <filename.iws>. The user must manually make any custom or site
specific changes to the overwritten files.

• OBSTBL.TXT: contains a list of datafill files that were obsoleted and removed
The original file content with its custom data is saved in directory
C:\MPXBASE\TMP to a file in the format <filename.iws>.

In addition to overwritten datafill files, all files in directory C:\WINDOWS that have an
.IWS extension are the previous versions of files that were modified during the installa
or upgrade process. For example, MPXINI is the old version of MPXINI.INIthat resid
on the IWS position prior to installation. These files might contain data that you wan
retrieve and put back in the new versions of the files.

To see what files were affected in this manner, enter the commanddir *.iws in the
C:\WINDOWS directory, and pressEnter.

Recommendation: After installing an IWS update, check the directories C:\ and
C:\WINDOWS for any files with an .IWS extension. Also check the CHGTBL.TXT,
NEWTBL.TXT and OBSTBL.TXT files in the C:\MPXBASE\TMP directory for any
new, modified, or obsoleted datafill files. Any custom changes regarding position or 
specific information needed in the new corresponding files will require manual
modifications. The changes can be made using the IWS provisioning tool or any Wind
text editor (such as Wordpad or Notepad). The provisioning tool is the preferred metho
editing datafill files because it provides error checking. For more information on using
IWS provisioning tool, refer toTOPS IWS RAMP and Provisioning User’s Guide,297-
2251-015.

Table 3 lists datafill files that are new, changed, or removed as a result of an upgrad
IWS 17.0. The datafill files that are added, changed, or removed depend both on the
previously installed IWS load (IWS 9.0, 10.0, or 11.0) and on which of the IWS
application disks (NTOA or NTDA, or both) are applied as part of the upgrade to IWS
12.0.

Table 3. Files changed by upgrade to IWS 17.0

Update IWS 9.0 to
12.0

Update IWS10.0
to 12.0

Update IWS 11.0
to 12.0

Files changed Files changed Files changed

* = Deleted file # = New file
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4.2.1  IWS release 13.0 datafill information

This sections is for upgrades from IWS 10.0, IWS 11.0, or IWS 12.0 to IWS release 
only. IWS releases prior to IWS 10.0 must first be upgraded to either IWS 10.0, 11.0
12.0 and properly datafilled before being upgraded to release 13.0. The procedures
updating TOPS IWS software can be found in theTOPS IWS Base Platform User’s Guide
297-2251-010.

For a new IWS position pre-loaded with IWS 13.0, this section does not apply. Refer
Section 4.3, "Inserting IWS datafill information," on page 51 for the procedure for
installing required datafill.

Under the old software upgrade method, when the preserve datafill option was selec
only user modified .LNG and .TBL files were preserved. All .INI files associated with
particular application upgrade were automatically renamed from .INI to .IWS in the
C:\WINDOWS directory. In their place, the new default .INI template files were
automatically installed. This happened regardless of whether any changes had been
to the .INI file in the new release. Any custom changes made to the original .INI file
regarding position or site-specific information would then have to be manually insert
into the new .INI file.

As of IWS release 13.0, this process has changed. If a working IWS position is bein
upgraded from IWS release 11.0 or 12.0, and the preserve datafill option is selected

CASEAPP.LNG CASEAPP.LNG CASEAPP.LNG
CASESFKY.LNG CASESFKY.LNG CASESFKY.LNG
MPXINI.INI POSMSA.LNG POSMSA.LNG
MPXPARM.INI XCLLORIG.TBL XCLLORIG.TBL
NTOAINI.INI MPXINI.INI
OACALLD.LNG * MPXPARM.INI
OACINFO.LNG * SCRSINI.INI *
OIACIW.LNG XFNCTS.TBL
PCCCINFO.LNG XKEYMAC.TBL #
POSMSA.LNG XTGDSPL.TBL
SCRPTINI.INI
SCRSINI.INI *
XCLLORIG.TBL
XFNCTS.TBL
XKEYMAC.TBL #
XOAOPRSK.TBL*
XTGDSPL.TBL

Table 3. Files changed by upgrade to IWS 17.0

Update IWS 9.0 to
12.0

Update IWS10.0
to 12.0

Update IWS 11.0
to 12.0

* = Deleted file # = New file
297-2251-201 Preliminary 05.01 November 2002
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affected .INI files are handled as before. However, the new install process now scan
new .INI file, looking at all the sections and entries. Then the respective .IWS file is
examined for matching sections and entries. If a match is found, the value is extract
from the .IWS file and placed in, or added to, the new .INI file. If no matching values
found, the IWS default value is used in the .INI file. The end result of this new proce
that any custom changes that are still relevant to the new .INI file regarding position 
site-specific information are automatically transferred into the new .INI file.

Note: An exception to this process is when an IWS defaultvalue has become obsolete or
the defaultvalue has changed. In this case, the old value from the .IWS file is not
transferred to the new .INI file.

The benefits of this new process are many. First, it ensures that the user has the lat
version of the .INI file. Also, since the process scans the .IWS files only for entries tha
found in the new .INI files, obsolete entry values are not carried forward. Finally, this
process ensures that any new values or entries that are added in the file will be set 
default value. The user still has the option of modifying the new IWS file using the IW
provisioning tool or any Windows text editor (such as Wordpad or Notepad). The
provisioning tool is the preferred method of editing datafill files because it provides e
checking. For more information on using the IWS provisioning tool, refer toTOPS IWS
RAMP and Provisioning User’s Guide,297-2251-015.
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Table 4 lists datafill files that are new, changed, or removed as a result of an upgrad
IWS 13.0. The datafill files that are added, changed, or removed depend both on the
previously installed IWS load (IWS 10.0, 11.0, or 12.0) and on which of the IWS
application disks (NTOA or NTDA, or both) are applied as part of the upgrade to IWS
13.0.

4.2.2 Datafill – Determining user-modified files

A datafill disk should be created that contains all user-modified files. Any IWS file th
contains site- or position-specific information should be backed up on the datafill dis
Files with site- or position-specific information include, but are not limited to,
MPXINI.INI, MPXNET.INI and HOSTS located in the C:WINDOWS directory. Other
commonly modified IWS files include table files (.TBL) and language files (.LNG), whi
are located in the C:\MPXBASE\DATAFILL directory. The customer should provide a
complete listing of all user-modified files and tables to include on the datafill disk.

If a complete listing of user-modified files is not available, a check of all IWS datafill fi
is recommended. To do this, compare the template files located in the
C:\MPXBASE\TOOLS\TEMPLATE directory to their corresponding files located in th
C:\WINDOWS and C:\MPXBASE\DATAFILL directories. For example, the template fi
MPXINI.TPL corresponds to the file MPXINI.INI located in C:\WINDOWS.

The .TPL files are the default template files provided by Nortel Networks. By compa
the datafill file to the corresponding .TPL file, you should be able to determine wheth
that file has been modified by the customer. If a file does not correspond exactly to i
template (.TPL) file, the file has been modified by the customer and should therefore
included on the datafill disk.

To compare the .INI, .KBD, .LNG, .SCR, or .TBL files to their template files, do the
following:

Note: The following steps use keyboard commands such asCtrl +Esc that are, by default,
disabled in the IWS software. See Section 3.0 on page 25 for information concernin

Table 4. Files changed by upgrade to IWS 13.0

Update IWS 10.0
to 13.0

Update IWS 11.0
to 13.0

Update IWS 12.0
to 13.0

Files changed Files changed Files changed
CASEAPP.LNG CASEAPP.LNG None
CASESFKY.LNG CASESFKY.LNG
MPXINI.INI POSMSA.LNG
MPXPARM.INI XCLLORIG.TBL
POSMSA.LNG
XCLLORIG.TBL
XFNCTS.TBL
XKEYMAC.TBL
XTGDSPL.TBL
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enabling required keyboard commands. However, a customer-supplied mouse may 
used in place of the keyboard commands, if installed and connected.

From the Windows desktop

1 Press Ctrl +Esc  to open the Start menu.

2 From the Start menu, press P and then the right arrow key to access Programs.

3 Use the arrow keys to move to the MS-DOS Prompt, and press Enter .

4 At the C:\WINDOWS prompt, type dir *.ini/on>ini.txt , and press Enter .

This lists all the .INI files in the C:\WINDOWS directory, sorted in alphabetical order by
name, and redirects the output to the file INI.TXT in the C:\WINDOWS directory. The
file name INI.TXT is used here as an example. Any file or naming convention can be
used.

5 At the C:\WINDOWS prompt, type cd\mpxbase\datafill , and press Enter .

6 At the C:\MPXBASE\DATAFILL  prompt, type dir *.*/on>datafill.txt , and
press Enter .

This lists all the files in the C:\MPXBASE\DATAFILL directory, sorted in alphabetical
order (by name), and redirects the output to the file DATAFILL.TXT which will be
located in the C:\MPXBASE\DATAFILL directory. The file name DATAFILL.TXT is used
here as an example. Any file or naming convention can be used.

7 At the C:\MPXBASE\DATAFILL prompt, type cd\mpxbase\tools\template , and
press Enter .

8 At the C:\MPXBASE\TOOLS\TEMPLATEprompt, type dir *.*/on>template.txt
and press Enter .

This lists all the files in the C:\MPXBASE\TOOLS\TEMPLATE directory, sorted in
alphabetical order (by name), and redirects the output to the file TEMPLATE.TXT
which will be located in the C:\MPXBASE\TOOLS\TEMPLATE directory. The file name
TEMPLATE.TXT is used here as an example. Any file or naming convention can be
used.

9 At the C:\MPXBASE\TOOLS\TEMPLATE prompt, type exit , and press Enter.

This returns you to Windows.

10 Press Ctrl +Esc  to open the Start menu.

11 From the Start menu, press P and then the right arrow key to access Programs.

12 Use the arrow keys to move to Windows Explorer, and press Enter .

This takes you to the Exploring dialog box.

13 If the contents of the C drive are displayed, proceed to step 14. If the contents of the C
drive are not displayed, follow these steps:

a Tab to the Folders pop-up dialog box.

b Press the right or down arrow key to expand the pop-up menu.

c Use the arrow keys to select the C drive, and press Enter .

14 Press the Tab key to go to the Contents of the IWS (C:) dialog box.

15 Use the arrow keys to select the Mpxbase folder.

16 Press Enter  to expand the Mpxbase folder.

17 Use the arrow keys to select the Datafill folder.

18 Press Enter  to expand the Datafill folder.
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19 Use the arrow key to scroll down to the text file created in step 6, in this case
datafill.txt.

20 Press Enter  to open the datafill.txt file.

21 Press Alt +Tab to go back to the Exploring dialog box.

22 Press the Tab key to return to the All Folders section of the Exploring dialog box.

23 Use arrow keys to select the Mpxbase\Tools folder.

24 Press the right arrow key to expand the Tools folder.

25 Use the arrow keys to select the Template folder.

26 Press the Tab key to move to the Contents of Template section of the Exploring dialog
box.

27 Use the arrow key to scroll down to the text file created in step 8, in this case
template.txt.

28 Press Enter  to open the template.txt file.

29 Press Alt +Tab to go back to the Exploring dialog box.

30 Press the Tab key to return to the All Folders section of the Exploring dialog box.

31 Use the arrow keys to select the Windows folder.

32 Press the Tab key to move to the Contents of the Windows section of the Exploring
dialog box.

33 Use the arrow keys to scroll down to the text file created in step 4, in this case ini.txt.

34 Press Enter  to open the ini.txt file.

35 Arrange the three windows with the open text files so they can all fit on the screen at
the same time. Follow these steps:

a Press Alt +Tab to select one of the windows with a text file.

b To change the size of the window, press Alt +Spacebar +S and use the arrow
keys.

c To position the windows on the screen, press Alt +Spacebar +M and use the arrow
keys.

d Use the Alt +Tab key combination to switch between the open files while sizing
and positioning the windows.

36 Using Table 5, “IWS template file (.TPL) cross-reference“ on page 49, compare the
size, date, and time stamp of the various template files with those of the correspond-
ing files in either the C:\MPXBASE\DATAFILL or C:\WINDOWS directories. Note any
file that does not match exactly for inclusion on the datafill disk.

Notes:

• Prior to IWS 11.0, the HOSTS file was located in directory C:\PATHWAY. A
of IWS release 11.0, the HOSTS file is located in directory C:\WINDOWS

• The use of an FT router to access a DAS is not supported in IWS release
or later. If you are upgrading NTDA to IWS version 11.0 or later but keepin
the datafill from an earlier IWS release, the FT router option must be remo
from the nonregistering applications in the MPXINI.INI file. Failure to remov
this will result in an error at the startup of the IWS position.
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• If you are upgrading to IWS 11.0 or later but keeping the datafill from an
earlier release of XKBOARD.TBL, be aware that three scan codes have b
changed. Scan codes 91, 92, and 93 have been changed to scan codes 11
and 121, respectively. If the old scan codes were assigned, use the KeyB
utility to restore functionality to these keys. For information on using the
KeyBind utility, refer toTOPS IWS RAMP and Provisioning User’s Guide,
297-2251-015.

Table 5. IWS template file (.TPL) cross-reference

C:\MPXBASE\
C:\WINDOWS

C:\MPXBASE\
C:\WINDOWS

TOOLS\TEMPLATE DATAFILL TOOLS\TEMPLATE DATAFILL

AACTWSFK.TPL AACTWSFK.LNG PDCALLD.TPL PDCALLD.LNG
APPLMENU.TPL APPLMENU.LNG POSMSA.TPL POSMSA.LNG
ASSGNACT.TPL ASSGNACT.LNG POSPRFLG.TPL POSPRFLG.LNG
BHMIMSA.TPL BHMIMSA.LNG POSPRFSK.TPL POSPRFSK.LNG
BKCALLBD.TPL BKCALLBD.LNG SASFK.TPL SASFK.LNG
BKCALLSK.TPL BKCALLSK.LNG SCRPTIN.TPL SCRPTIN.INI
CASEAPP.TPL CASEAPP.LNG SCRPTLNG.TPL SCRPTLNG.LNG
CASESFSK.TPL CASESFSK.LNG SCRPTSCR.TPL SCRPTSCR.SCR
CLNTTCPI.TPL CLNTTCPI.INI SVCSMENU.TPL SVCSMENU.LNG
DATABASE.TPL DATABASE.LNG TRBLMENU.TPL TRBLMENU.LNG
ESTWNDW.TPL ESTWNDW.LNG UMP.TPL UMP.INI
FNCMENU.TPL FNCMENU.LNG XALTRTE.TPL XALTRTE.TBL
ICQUSFK.TPL ICQUSFK.LNG XAPPL.TPL XAPPL.TPL
ICSFK.TPL ICSFK.LNG XCASTS.TPL XCASTS.TBL
IDLMSA.TPL IDLMSA.LNG XCDFA.TPL XCDFA.TBL
LGNSFK.TPL LGNSFK.LNG XCLLORIG.TPL XCLLORIG.TBL
LOGON.TPL LOGON.LNG XCORGXSC.TPL XCORGXSC.TBL
LOGOTEXT.TPL LOGOTEXT.LNG XCOTHSD.TPL XCOTHSD.TBL
MPXINI.TPL MPXINI.INI XCT4Q.TPL XCT4Q.TBL
MPXNET.TPL MPXNET.INI XCT4QXSC.TPL XCT4QXSC.TBL
MPXPARM.TPL MPXPARM.INI XCTRYDIR.TPL XCTRYDIR.TBL
MPXTOP.TPL MPXTOP.INI XDARBLG.TPL XDARBLG.TBL
NTDA.TPL NTDA.KBD XDBCLASS.TPL XDBCLASS.TBL
NTDACORG.TPL NTDACORG.TBL XDBCOMP.TPL XDBCOMP.TBL
NTDACT4Q.TPL NTDACT4Q.TBL XDBERROR.TPL XDBERROR.TBL
NTDAINI.TPL NTDAINI.INI XDBSRVC.TPL XDBSRVC.TBL
NTDAMISC.TPL NTDAMISC.LNG XDBVRSTN.TPL XDBVRSTN.TBL
NTDAMSA.TPL NTDAMSA.LNG XFNCTS.TPL XFNCTS.TBL
NTDASPID.TPL NTDASPID.TBL XINFBRSN.TPL XINFBRSN.TBL
NTOAINI.TPL NTOAINI.INI XINFBSVC.TPL XINFBSVC.TBL
OASAICW.TPL OASAICW.LNG XKBOARD.TPL XKBOARD.TBL
OGTMENU.TPL OGTMENU.LNG XKEYMAC.TPL XKEYMAC.TBL
OIACIW.TPL OIACIW.LNG XLANG.TPL XLANG.TBL
OIAMSA.TPL OIAMSA.LNG XOGTMENU.TPL XOGTMENU.TBL
OPADMSFK.TPL OPADMSFK.LNG XOLNSEQP.TPL XOLNSEQP.TBL
OPPRFLNG.TPL OPPRFLNG.LNG XOLNSRST.TPL XOLNSRST.TBL
OPPRFSFK.TPL OPPRFSFK.LNG XPCCSK.TPL XPCCSK.TBL
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4.2.3  Create datafill disk

If an up-to-date datafill disk exists, proceed to Section 4.2.4 on page 51. To create a d
disk when one does not exist, follow these steps:

At the PC

1 Place a formatted 1.44MB floppy disk in the A drive.

2 Create directories on the backup disk.

a At the C:\> prompt type md a:\windows and then press the Enter key to create
directory path A:\WINDOWS on the backup disk.

b At the C:\> prompt type md a\:mpxbase\datafill  and then press the Enter key to
create directory path A:\MPXBASE\DATAFILL on the backup disk.

3 To copy files to the datafill disk do the following from the C:\ prompt:

a Type Copy C:\windows\system32\drivers\hosts\etc\hosts a:\windows .

b Each TOPS IWS position type (general, gateway and RAMP) has a uniquely
configured variation of the MPXINI.INI file. Therefore there should be three
variations of this file on the datafill disk. Since three files with the same name
cannot exist in a common directory on the datafill disk, use the following (or
similar) naming method to maintain these files:

• For a general position type

Copy C:\windows\mpxini.ini a:\windows\mpxini.gen

and then press the Enter key.

• For a gateway position type

Copy C:\windows\mpxini.ini a:\windows\mpxini.gty

and then press the Enter key.

• For a RAMP position type

Copy C:\windows\mpxini.ini a:\windows\mpxini.rmp

and then press the Enter key.

c Type
Copy C:\windows\mpxnet.ini a:\windows
and then press the Enter key.

OPRSTATS.TPL OPRSTATS.LNG XPCCTRIG.TPL XPCCTRIG.TBL
OPRSTSFK.TPL OPRSTSFK.LNG XRBLG.TPL XRBLG.TBL
PANOACT.TPL PANOACT.LNG XRCXSC.TPL XRCXSC.TBL
PASSWORD.TPL PASSWORD.LNG XSERVS.TPL XSERVS.TBL
PASSWSFK.TPL PASSWSFK.LNG XSPIDXSC.TPL XSPIDXSC.TBL
PCCCINFO.TPL PCCCINFO.LNG XTGDSPL.TPL XTGDSPL.TBL
PCCDBSK.TPL PCCDBSK.LNG XTROUBLE.TPL XTROUBLE.TBL

Table 5. IWS template file (.TPL) cross-reference (Continued)

C:\MPXBASE\
C:\WINDOWS

C:\MPXBASE\
C:\WINDOWS

TOOLS\TEMPLATE DATAFILL TOOLS\TEMPLATE DATAFILL
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d Copy any user-modified datafill files to the datafill disk by typing
Copy C:\mpxbase\datafill\<filename.ext> a:\mpxbase\datafill
and then press the Enter key.

• Repeat this step until all user-modified datafill files are copied to the disk.

e Copy any other customer-modified IWS files to the appropriate locations on the
datafill diskette. Store the datafill disk (or set of disks if more than one disks is
required) in a safe location for future reference.

Store the datafill disk in a safe location for future reference. This datafill disk will be u
to complete the IWS software installation or upgrade later in this procedure. See Se
4.3, "Inserting IWS datafill information," on page 51.

4.2.4 Back up the datafill disk

Before you install or update to a new release of IWS software, create a copy of the exi
datafill disk. This copy will serve as the starting point for the new datafill disk for the
updated IWS software. The original datafill disk must be an accurate record of the fi
that were customized with site- or position-specific information. If you are unsure of 
accuracy of the existing datafill disk, make a complete check of all IWS datafill files
before performing the IWS upgrade. For information on performing a complete chec
all IWS datafill files, see Section 4.2.2, "Datafill – Determining user-modified files," o
page 46.

Use the following procedure to create a copy of the existing datafill disk.

From the Windows desktop

1 Press Ctrl +Esc  to open the Start menu.

2 From the Start menu, press P and then the right arrow key to access Programs.

3 Use the arrow keys to move to Windows Explorer, and press Enter .

4 Press the Tab key and the arrow keys to select the My Computer icon.

5 Press Enter  to open the My Computer dialog window.

6 Use the arrow keys to highlight the A drive icon.

7 Press Alt +F to open the File pull-down menu.

8 Use the arrow keys to move down to the Copy Disk selection, or press Y.

9 Press Enter  to open the Copy Disk window.

10 Insert the datafill disk to be copied into the A drive.

11 Select the Start button and press Enter , or press S to begin copying the disk.

12 When prompted, remove the disk from the A drive, insert a blank formatted floppy in
drive A, select the OK button, and press Enter .

13 When the copy process is complete, select the Close button and press Enter  or C.

4.3  Inserting IWS datafill information

This section contains information about inserting datafill for IWS software release 10
11.0, and 12.0 or an upgrade to IWS 13.0 if the preserve datafill option was not sele
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during the update process. If the preserve datafill option was selected, see Section 
"IWS release 13.0 datafill information," on page 44 for additional information concern
IWS release 13.0 datafill.

This chapter describes the process for copying the site- or position-specific informat
from the datafill disk to the appropriate locations on the IWS position.

Remember that there should be three variations of the MPXINI.INI file on the datafil
disk:

• general position = MPXINI.GEN

• gateway position = MPXINI.GTY

• RAMP = MPXINI.RMP

Select the proper version of the file for the position to be datafilled.

Use the following procedure to copy the files from the datafill disk.

1 Insert the datafill disk into drive A.

2 At the C:\  prompt, type

>copy a:\windows\mpx*.ini c:\windows

and press Enter .

3 At the C:\  prompt:

• For a general position, type

>copy a:\windows\mpxini.gen c:\windows\mpxini.ini

and press Enter .

• For a gateway position, type

>copy a:\windows\mpxini.gty C:\windows\mpxini.ini

and press Enter .

• For a RAMP, type

>copy a:\windows\mpxini.rmp C:\windows\mpxini.ini

and press Enter .

4 Copy the a:\datafill files. At the C:\  prompt, type

>copy a:\mpxbase\datafill\*.* c:\mpxbase\datafill

and press Enter .

5 Copy the a:\windows\HOSTS file. At the C:\  prompt, type

>copy a:\windows\hosts c:\windows\system32\drivers\etc

and press Enter .

6 The preceding files are the ones most commonly modified by the customer. The cus-
tomer should provide a complete listing of all user-modified files on the datafill disk.
Copy any other customer-modified files to the appropriate locations on the IWS posi-
tion.

7 Reboot the position to put the new settings into effect.
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5.0  Appendix: Configuring a preloaded TOPS IWS position

Nortel contracts with various software integrators to pre-load and configure TOPS IW
settings. Nevertheless, some configuration and datafill of site-specific parameters m
specified. This section contains the procedure for setting up TOPS IWS position net
parameters.

5.1  Changing the Network Settings of an IWS Position

It may be necessary to change or reset the IP address of an IWS position (because
LAN setup change for example).

1 If already at the Windows XP Professional desktop, proceed to step 2. If the IWS base
or RAMP application is running, follow substeps a through d to close the application.

a Press Ctrl+Alt+Delete and select the Task Manager.

b Select the Applications Tab if it is not already selected.

c Use the down arrow key to highlight MPX BASE Application or Remote Access
Maintenance Position.

d Use the Tab key to highlight the End Task button and then press the Enter key to
end the application. (Close both the IWS base and RAMP applications if both are
running.)

2 Press Ctrl+Esc to open the Start menu.

3 Press the S key, and then press the Enter C to open the Control Panel.

4 Use the arrow keys to highlight Network Connections, and then press the Enter key to
open the Network Connections box.

FIGURE 31. Control Panel highlighting Network Connections
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5 Use the Tab and arrow keys to open the Local area Connections icon.

FIGURE 32. Local Area Connection location

6 Press the Enter key to display the Local Area Connection Status box.

FIGURE 33. Local Area Connection Status box.

7 Tab to the Properties box and press Enter.
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8 Select the Internet Protocol (TCP/IP) option.

FIGURE 34. Local Area Connection Properties box
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9 Press the Properties button to display the Internet Protocol (TCP/IP) Properties win-
dow.

FIGURE 35. Internet Protocol (TCP/IP) Properties window

Type in the IP address of the IWS position using the following format

nnn.nnn.nnn.nnn

where “n” is a segment of the IP address, and “.” separates two segments.

As an example, an IWS position with the IP address 128.1.12.32 must have the
computer name 128x1x12x32.

The subnet mask may also need to be updated, and can also be done in this window.
To add additional gateways, select the Advanced button and proceed to step 10
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FIGURE 36. Advanced TCP/IP Settings window

10 Routers (called gateways by Windows software) are used to access external data-
bases. These are not the IWS gateway positions that connect to the DMS switch. The
routers need to be identified in the Installed gateways list box. If the IPs are listed cor-
rectly, go directly to the next step. Otherwise, continue with this step to identify the
database routers.

First, identify the two ASN routers that access the external DA and CCDB databases
by entering the IP addresses of the LAN-segment connections (not the WAN-segment
connections). The addresses shown here are only examples, the actual address you
enter will be different. Note that each of the two routers must route to both the DA
server and the CCDB server. After the IP addresses for the DA and CCDB routers are
entered, then the addresses of any other routers can be entered. A total of five IP
addresses can be listed.

Each IP address is entered as follows:

a Tab to the New gateway address box and type in the IP address.
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b Press Alt+A. Check that the added IP address is listed in the Installed gateways
box.

c Perform these steps as needed up to five times.

FIGURE 37. IP Addresses for DA and CCDB Routers

11 After changing the IP address, select OK.

12 Return to the Control Panel to access the Systems properties box. This is required to
change the computer’s name.

13 In the Systems properties box, select the tab for Computer name.

IWS
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128.240.10.11

Secondary
server

Links

WAN
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Directory 1

server
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Primary
server

Primary
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Calling card
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IWS
LAN
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ASN Routers

Router

Router

Router

Router

DMS
switch
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DA and CCDB
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(gateways)
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FIGURE 38. Computer Name tab in the System Properties window
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14 Select the Change button to display the Computer Name Changes window.

FIGURE 39. Computer Name Changes window

15 Type in new Computer name. It must exactly match the IP address entered in Step 9

16 Select OK.
Note:  if the OK button remains grayed out, nothing has been changed. If you replace
the IP address with the same number, it will remain grayed out.

17 A message appears alerting the user that the computer must be restarted for the
change to take effect. Select OK.

FIGURE 40. Name Change restart alert

18 After clicking ok, the system returns you to the System Properties menu.
DMS-100 Family TOPS IWS Network Configuration Guide  IWS 17.0 and up



61
FIGURE 41. System Properties window denoting changes

19 Note the new message at the bottom of the screen:

FIGURE 42. Change alert on the System Properties window

20 Select OK.
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21 The system will prompt you to restart the computer.

FIGURE 43. Restart prompt

Once you restart the computer, the IP address of the IWS Position will be changed.

22 Proceed to Section 4.0, "TOPS IWS position datafill", on page 41.
DMS-100 Family TOPS IWS Network Configuration Guide  IWS 17.0 and up



63
6.0  Revisions

6.1  Revisions for release 17.0

Released for IWS 17.0 with the following changes:

• Updated all subheadings in Section 3.0 “Keystroke commands (Alt+Tab,
Ctrl+Esc, and Ctrl+Alt+Delete)”

• Updated Section 4.2.3 “Create datafill disk”

• Updated Section 5.1 “Changing the Network Settings of an IWS Position”

6.2  Revisions for release 15.2

• Released for minor formatting changes. No updates to technical content.

6.3  Revisions for release 15.0

• Released for minor formatting changes. No updates to technical content.

6.4  Revisions for release 14.0

• Book revised, edited, and corrected throughout.

6.5  Revisions for release 13.0

• Initial release of this book.
DMS-100 Family TOPS IWS Network Configuration Guide  IWS 17.0 and up



64
297-2251-201 Preliminary 05.01 November 2002



65
7.0  Index

Numerics
10 Base-T11, 13, 16

A
Alt+Spacebar+M48

Alt+Spacebar+S48

Alt+Tab 25, 26

alttab26

AUI port 17

B
backup files43

baud rate18

BayStack 150-series Ethernet hub9

C
Cascade ports17

CHGTBL.TXT 43

COM1 18

Ctrl+Alt+Delete25, 26, 32, 36, 53

Ctrl+Esc25

D
DAS 48

DB-9 19

Default Gateway17

Directory One9, 11

DMS-200 ETMS11

E
Ethernet LAN9, 11

F
FT router48

H
HOSTS46, 48

Hub configuration terminal18

Hub IP address17

I
IP address17, 56

K
KeyBind 49

L
LAN 9, 11, 12

LED display13

M
MDI/MDI-X switch 16

MDI-X port 16

MPXINI.INI 46, 48, 50, 52

MPXNET.INI 46

N
NEWTBL.TXT 43

NTAR25BF12

NTDA 43, 46

NTNX51DA 12

NTOA 43, 46

O
OBSTBL.TXT 43

P
provisioning tool43

R
RAMP 50, 52

RJ-4516

router57

RS-23217

S
Site Networking Package9
SNP9, 17

Start Menu Enabled33

Subnet Mask17

V
VT-100 18

X
XKBOARD.TBL 49
DMS-100 Family TOPS IWS Network Configuration Guide  IWS 17.0 and up



66
297-2251-201 Preliminary 05.01 November 2002





DMS-100 Family

TOPS IWS
Network Configuration Guide

Copyright © 2000 - 2002 Nortel Networks
All Rights Reserved

NORTEL NETWORKS CONFIDENTIAL: The
information contained herein is the property of Nortel
Networks and is strictly confidential. Except as expressly
authorized in writing by Nortel Networks, the holder shall keep
all information contained herein confidential, shall disclose the
information only to its employees with a need to know, and
shall protect the information, in whole or in part, from
disclosure and dissemination to third parties with the same
degree of care it uses to protect its own confidential
information, but with no less than reasonable care. Except as
expressly authorized in writing by Nortel Networks, the holder
is granted no rights to use the information contained herein.

Information subject to change without notice. Nortel Networks
reserves the right to make changes in design or components
as progress in engineering and manufacturing may warrant.

DMS, NORTEL NETWORKS, and TOPS are trademarks of
Nortel Networks. Microsoft Windows is a trademark of
Microsoft Corporation.

Publication number: 297-2251-201
Product release: IWSS0170
Document release: Preliminary 05.01
Date: November 2002
Printed in the United States of America


	TOPS IWS Network Configuration Guide
	TOPS IWS Network Configuration Guide
	Publication history
	November 2002
	Document version.issue 05.01
	Preliminary release for IWS 17.0 and up
	(Gate 2 release)
	September 2001
	Document version.issue 04.02
	Standard release for IWS 15.2 and up
	(Gate 3 release)
	September 2001
	Document version.issue 04.01
	Preliminary release for IWS 15.2 and up
	(Gate 2 release)
	June 2001
	Document version.issue 03.02
	Standard release for IWS 15.0 and up
	(Gate 3 release)
	April 2001
	Document version.issue 03.01
	Preliminary release for IWS 15.0 and up
	(Gate 2 release)
	September 2000
	Document version.issue 02.01
	Standard release for IWS 14.0 and up
	(Gate 2 CD release)
	August 2000
	Document version.issue 01.02
	Standard release for IWS 13.0
	(Gate 3 CD release)
	March 2000
	Document version.issue 01.01
	Standard release for IWS 13.0
	(Gate 2 release)

	1.0 Introduction
	1.1 Configuring the Ethernet hub
	1.2 Datafilling the IWS position

	2.0 Ethernet hub configuration
	Figure 1. Directory One Ethernet LAN configuration
	2.1 Ethernet LAN hardware
	Figure 2. Components of the LAN

	2.2 Ethernet hub
	2.2.1 BayStack 150 description
	2.2.2 LED display
	Table 1. BayStack 150 LED display details �

	2.2.3 Ethernet ports
	Figure 3. BayStack 150 hub Ethernet port specifications and RJ-45 connector pinout

	2.2.4 MDI/MDI-X switch
	2.2.4.1 Interconnect method

	2.2.5 RS-232 communication port
	Figure 4. RS-232 communication port specifications and cable pinout

	2.2.6 AUI port
	2.2.7 Cascade ports

	2.3 Configuring the BayStack 150
	Table 2. IP address list
	2.3.1 Set up a hub configuration terminal
	1 Press Ctrl+Esc to open the Start menu.
	2 Use the up and down arrow keys to select Run, and press Enter.
	3 In the Run dialog box type hypertrm.exe, and press Enter to start the HyperTerminal application.
	4 Tab to the Cancel button, and press Enter.
	5 Press Alt+F to open the File menu.
	6 In the File menu, use the up and down arrow keys to select Properties. Press Enter.
	7 Use the Tab key to select the Connect Using pull-down menu.
	8 Use the right and left arrow keys to select the port on the terminal to be used for the hub con...
	9 After selecting the port, tab to the Configure button. Press Enter.
	10 Verify that the following parameters are correctly set:
	11 To set the Bits per second (baud rate), tab to the Bits per second pull-down menu and use the ...
	12 To set the Data bits parameter, tab to the Data bits pull-down menu and use the left or right ...
	13 To set the Parity parameter, tab to the Parity pull-down menu and use the left or right arrow ...
	14 To set the Stop bits parameter, tab to the Stop bits pull-down menu and use the left or right ...
	15 To set the Flow control parameter, tab to the Flow control pull-down menu and use the left or ...
	16 Tab to the OK button, and press Enter.
	17 Use the Tab key to select the Phone Number tab of the New Connection Properties dialog box. Th...
	18 Use the Tab key to select the Emulation pull-down menu.
	19 Using the left and right arrow keys, select the VT100 option.
	20 Tab to the OK button, and press Enter.
	2.3.1.1 Connect a terminal or PC to the hub
	Figure 5. Terminal connection to the BayStack 150 hub
	1 Study Figure�6, which shows the pin assignments for the interconnect cable between the terminal...

	Figure 6. Communication port pin and signal information
	2 Connect the DB-9 plug end of the appropriate straight-through cable to the communications port ...
	3 Connect the remote end of the cable into the appropriate port on the terminal or PC.



	2.3.2 Connect power to the hub
	1 Connect the power cable that comes with the hub to the power connector on the back of the hub.
	2 Turn on power to the hub by plugging the power cable into an outlet.
	Figure 7. Power-on self-diagnostic display

	2.3.3 Edit IP settings
	1 While the message DUPLICATED IP CHECKING:(Hit CTRL-C to stop system boot/load)is displayed, pre...
	Figure 8. BayStack 150 Boot Main Menu display
	2 From the Boot Main Menu, press j to display the IP Configuration Menu (see Figure�9).

	Figure 9. IP Configuration Menu
	3 From the IP Configuration Menu, press i to set the hub IP address.
	4 Enter the IP address you have selected, and press Enter.
	5 Press s to set the subnet mask.
	6 Enter the subnet mask number for your network, and press Enter.
	7 Press g to set the default gateway.
	8 Enter the IP address for your default gateway, and press Enter.
	9 Press Esc to return to the Boot Main Menu.


	2.3.4 Edit boot configuration settings
	1 Press m to toggle the boot mode to EEPROM.
	2 Press m to toggle the boot mode to local.
	3 Press f to toggle the config load mode to local.
	4 Press i to toggle the image load mode to local.
	5 Press w to save all parameter values to EEPROM.
	6 Press z, then select y, and press Enter to reboot the hub.



	3.0 Keystroke commands (Alt+Tab, Ctrl+Esc, and Ctrl+Alt+Delete)
	Figure 10. Windows or DOS environment IWS keyboard layout
	3.1 Enabling Alt+Tab
	1. If the IWS logo window has focus, shut down the IWS base application as follows:
	2. Press Ctrl+Esc to open the Start menu.
	3. Go to Settings, and select Control Panel.
	4. Double click on the System Icon to open the System Properties screen.
	5. Go to the Advanced tab of Systems Properties
	6. Click on Environmental variables button at bottom of the screen
	FIGURE 13. System Properties Advanced tab

	7. Display the Environmental variables screen.
	8. Change the ALTTAB variable in the Environmental variables screen.
	a. Click on ALTTAB in the System variables box
	b. Click on the Edit button for the System variables.
	c. Change the Variable value to 1. Note: The default is 0, which represents off. A value of 1 rep...
	d. Click OK.
	e. Verify that the ALTTAB variable is set to 1 in the Environmental variables screen.
	f. Click OK to return to the System properties screen.
	g. Click OK to return to the Control panel.
	8. The Alt+Tab command is now permanently enabled for use at the IWS logo window.

	3.2 Control of Alt+Tab and Ctrl+Esc from RAMP
	1. If an IWS logo window has focus at the RAMP and Alt+TAb is NOT enabled on the position, shut d...
	2. Press Alt+Tab if needed to get a Remote Access Maintenance Position window.
	3. Press Alt+T to open the Tools menu.
	4. Press key P to open a Position Profile window.
	FIGURE 19. Profile of an IWS Position
	FIGURE 20. Profile of RAMP

	5. Press Alt+A to open an Applications Profile window.
	FIGURE 21. Applications Profile Window

	6. Press Alt+M to choose the Modify button and open an Application Parameter Modification window.
	FIGURE 22. Setting Start Menu Enabled to True
	FIGURE 23. Start Menu Enabled Set to True

	7. Use the Tab key and Enter keys to close the modification windows at the RAMP.

	3.3 Control of Ctrl+Alt+Delete from RAMP
	1. If an IWS logo window has focus at the RAMP and Alt+Tab is NOT enabled on the position, shut d...
	2. Press Alt+Tab if needed to get a Remote Access Maintenance Position window.
	3. Press Alt+T to open the Tools menu.
	4. Press key P to open a Position Profile window.
	FIGURE 24. Profile of an IWS Position
	FIGURE 25. Profile of RAMP

	5. Press Alt+A to open an Applications Profile window.
	FIGURE 26. Ctrl+Alt+Esc Enabled

	6. Press Alt+M to choose the Modify button and open an Application Parameter Modification window.
	FIGURE 27. Setting Ctrl+Alt+Esc Enabled to False
	FIGURE 28. Ctrl+Alt+Del is Disabled

	7. Use the Tab key and Enter keys to Close the Profile windows.


	4.0 TOPS IWS position datafill
	4.1 TOPS IWS provisioning tool
	Figure 29. TOPS IWS menu box
	Figure 30. Startiws pull-down menu

	4.2 Datafill information
	Table 3. Files changed by upgrade to IWS 17.0
	4.2.1 IWS release 13.0 datafill information
	Table 4. Files changed by upgrade to IWS 13.0

	4.2.2 Datafill – Determining user-modified files
	1 Press Ctrl+Esc to open the Start menu.
	2 From the Start menu, press P and then the right arrow key to access Programs.
	3 Use the arrow keys to move to the MS-DOS Prompt, and press Enter.
	4 At the C:\WINDOWS prompt, type dir *.ini/on>ini.txt, and press Enter.
	5 At the C:\WINDOWS prompt, type cd\mpxbase\datafill, and press Enter.
	6 At the C:\MPXBASE\DATAFILL prompt, type dir *.*/on>datafill.txt, and press Enter.
	7 At the C:\MPXBASE\DATAFILL prompt, type cd\mpxbase\tools\template, and press Enter.
	8 At the C:\MPXBASE\TOOLS\TEMPLATE prompt, type dir *.*/on>template.txt and press Enter.
	9 At the C:\MPXBASE\TOOLS\TEMPLATE prompt, type exit, and press Enter.
	10 Press Ctrl+Esc to open the Start menu.
	11 From the Start menu, press P and then the right arrow key to access Programs.
	12 Use the arrow keys to move to Windows Explorer, and press Enter.
	13 If the contents of the C drive are displayed, proceed to step 14. If the contents of the C dri...
	a Tab to the Folders pop-up dialog box.
	b Press the right or down arrow key to expand the pop-up menu.
	c Use the arrow keys to select the C drive, and press Enter.
	14 Press the Tab key to go to the Contents of the IWS (C:) dialog box.
	15 Use the arrow keys to select the Mpxbase folder.
	16 Press Enter to expand the Mpxbase folder.
	17 Use the arrow keys to select the Datafill folder.
	18 Press Enter to expand the Datafill folder.
	19 Use the arrow key to scroll down to the text file created in step 6, in this case datafill.txt.
	20 Press Enter to open the datafill.txt file.
	21 Press Alt+Tab to go back to the Exploring dialog box.
	22 Press the Tab key to return to the All Folders section of the Exploring dialog box.
	23 Use arrow keys to select the Mpxbase\Tools folder.
	24 Press the right arrow key to expand the Tools folder.
	25 Use the arrow keys to select the Template folder.
	26 Press the Tab key to move to the Contents of Template section of the Exploring dialog box.
	27 Use the arrow key to scroll down to the text file created in step 8, in this case template.txt.
	28 Press Enter to open the template.txt file.
	29 Press Alt+Tab to go back to the Exploring dialog box.
	30 Press the Tab key to return to the All Folders section of the Exploring dialog box.
	31 Use the arrow keys to select the Windows folder.
	32 Press the Tab key to move to the Contents of the Windows section of the Exploring dialog box.
	33 Use the arrow keys to scroll down to the text file created in step 4, in this case ini.txt.
	34 Press Enter to open the ini.txt file.
	35 Arrange the three windows with the open text files so they can all fit on the screen at the sa...
	a Press Alt+Tab to select one of the windows with a text file.
	b To change the size of the window, press Alt+Spacebar+S and use the arrow keys.
	c To position the windows on the screen, press Alt+Spacebar+M and use the arrow keys.
	d Use the Alt+Tab key combination to switch between the open files while sizing and positioning t...
	36 Using Table 5, “IWS template file (.TPL) cross-reference“ on page 49, compare the size, date, ...
	Table 5. IWS template file (.TPL) cross-reference�

	4.2.3 Create datafill disk
	1 Place a formatted 1.44MB floppy disk in the A drive.
	2 Create directories on the backup disk.
	a At the C:\> prompt type md a:\windows and then press the Enter key to create directory path A:\...
	b At the C:\> prompt type md a\:mpxbase\datafill and then press the Enter key to create directory...
	3 To copy files to the datafill disk do the following from the C:\ prompt:
	a Type Copy C:\windows\system32\drivers\hosts\etc\hosts a:\windows.
	b Each TOPS IWS position type (general, gateway and RAMP) has a uniquely configured variation of ...
	c Type Copy C:\windows\mpxnet.ini a:\windows and then press the Enter key.
	d Copy any user-modified datafill files to the datafill disk by typing Copy C:\mpxbase\datafill\<...
	e Copy any other customer-modified IWS files to the appropriate locations on the datafill diskett...

	4.2.4 Back up the datafill disk
	1 Press Ctrl+Esc to open the Start menu.
	2 From the Start menu, press P and then the right arrow key to access Programs.
	3 Use the arrow keys to move to Windows Explorer, and press Enter.
	4 Press the Tab key and the arrow keys to select the My Computer icon.
	5 Press Enter to open the My Computer dialog window.
	6 Use the arrow keys to highlight the A drive icon.
	7 Press Alt+F to open the File pull-down menu.
	8 Use the arrow keys to move down to the Copy Disk selection, or press Y.
	9 Press Enter to open the Copy Disk window.
	10 Insert the datafill disk to be copied into the A drive.
	11 Select the Start button and press Enter, or press S to begin copying the disk.
	12 When prompted, remove the disk from the A drive, insert a blank formatted floppy in drive A, s...
	13 When the copy process is complete, select the Close button and press Enter or C.


	4.3 Inserting IWS datafill information
	1 Insert the datafill disk into drive A.
	2 At the C:\ prompt, type
	> copy a:\windows\mpx*.ini c:\windows
	3 At the C:\ prompt:
	> copy a:\windows\mpxini.gen c:\windows\mpxini.ini
	> copy a:\windows\mpxini.gty C:\windows\mpxini.ini
	> copy a:\windows\mpxini.rmp C:\windows\mpxini.ini

	4 Copy the a:\datafill files. At the C:\ prompt, type
	> copy a:\mpxbase\datafill\*.* c:\mpxbase\datafill
	5 Copy the a:\windows\HOSTS file. At the C:\ prompt, type
	> copy a:\windows\hosts c:\windows\system32\drivers\etc
	6 The preceding files are the ones most commonly modified by the customer. The customer should pr...
	7 Reboot the position to put the new settings into effect.


	5.0 Appendix: Configuring a preloaded TOPS IWS position
	5.1 Changing the Network Settings of an IWS Position
	1 If already at the Windows XP Professional desktop, proceed to step 2. If the IWS base or RAMP a...
	a Press Ctrl+Alt+Delete and select the Task Manager.
	b Select the Applications Tab if it is not already selected.
	c Use the down arrow key to highlight MPX BASE Application or Remote Access Maintenance Position.
	d Use the Tab key to highlight the End Task button and then press the Enter key to end the applic...

	2 Press Ctrl+Esc to open the Start menu.
	3 Press the S key, and then press the Enter C to open the Control Panel.
	4 Use the arrow keys to highlight Network Connections, and then press the Enter key to open the N...
	5 Use the Tab and arrow keys to open the Local area Connections icon.
	6 Press the Enter key to display the Local Area Connection Status box.
	7 Tab to the Properties box and press Enter.
	8 Select the Internet Protocol (TCP/IP) option.
	9 Press the Properties button to display the Internet Protocol (TCP/IP) Properties window.
	10 Routers (called gateways by Windows software) are used to access external databases. These are...
	a Tab to the New gateway address box and type in the IP address.
	b Press Alt+A. Check that the added IP address is listed in the Installed gateways box.
	c Perform these steps as needed up to five times.

	FIGURE 37. IP Addresses for DA and CCDB Routers
	11 After changing the IP address, select OK.
	12 Return to the Control Panel to access the Systems properties box. This is required to change t...
	13 In the Systems properties box, select the tab for Computer name.
	14 Select the Change button to display the Computer Name Changes window.
	15 Type in new Computer name. It must exactly match the IP address entered in Step 9
	16 Select OK. Note: if the OK button remains grayed out, nothing has been changed. If you replace...
	17 A message appears alerting the user that the computer must be restarted for the change to take...
	18 After clicking ok, the system returns you to the System Properties menu.
	19 Note the new message at the bottom of the screen:
	20 Select OK.
	21 The system will prompt you to restart the computer.
	22 Proceed to Section 4.0, "TOPS IWS position datafill", on page 41.
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